REPORTneo

m; o

User manual

] 0y a3
e e )
:

=3

2/4/2021

Product line neo, version 6.x

The described functions can be used with the following ASC products:
EVOIPneo
EVOLUTIONneo / XXL / eco
INSPIRATIONneo

Please note that you can always find the most up-to-date technical documentation and product updates in the partner area on our
website at http://www.asctechnologies.com.

Copyright © 2021 ASC Technologies AG. All rights reserved.

Windows is a registered trademark of Microsoft Corporation. VMware® is a registered trademark of VMware, Inc. All other marks
and names mentioned herein may be trademarks of their respective companies.

ASC Technologies AG - Seibelstr. 2-4 - 63768 Hosbach - Germany






Contents @sc

Contents
1 General INformation ... 4
2 014 Yo 18 T2 4T ) o P 5
3 I = o L= 6
4 Start apPliCatioN ... ———————————————— 7
4.1 SINGIE TOGIN ...ttt et 7
4.2 (@76] 091 o] 1aT=11Te] TN [oTo |1 o [N PR R UPR R SUPP 8
4.3 ReqUESE NEW PASSWOId......ccccoi i e e e e e e 9
5 User interface REPORTNEO..... .. smeme e e 1
5.1 =] oY T- 1 (o FUR PP 11
511 Toolbar dashbOard ........ ... e a e 12
5.2 WGt SEHINGS ...t 12
5.2.1 TAD GENETAI ...t e e e e s rneeeean 12
522 Tab Additional SEttiNGS ......veeiie e 13
5.3 =TT IRV =T =Y oY o OSSP 14
5.31 10T ]| o 7= g =T oL SOOI 14
54 Detail report SEHINGS ....ooooiiiiie e 15
541 Tab Report SEHINGS ... 15
54.2 1K= o 3N LY SRR 16
543 Tab AQQregation........coo oo ————————————————————— 17
6 General functioNalities .........ccccceriiiceciei e 18
6.1 (O 1| I 0 o I | (o TSP RPN 18
6.2 ] PP 18
7 Create report Widget ..........ooo i rrcser e mn e e e s e 19
8 Configure Widget.........coviiiiiiiiir i ————————— 20
9 Configure rePort.... ... —————————— 21
10 Delete Widget ... ————— 22
List Of fIQUIeS ......ceiiiiiii s 23
List Of tables .......ciiiiiiii et 24
(€] [ X7 1 VSO P 25

- neo 6.x Rev. 2

3/25



1 General information \\Asc

1 General information

In the context of this document ASC represents ASC Technologies AG, its subsidiaries, branch
offices, and distributors. An up-to-date overview of the aforementioned entities can be found at
https://www.asctechnologies.com

ASC assumes no guarantee for the actuality, correctness, integrity or quality of the information
provided in the manuals.

ASC regularly checks the content of the released manuals for consistency with the described
hardware and software. Nevertheless, deviations cannot be excluded. Necessary revisions are
included in subsequent editions.

Some aspects of the ASC technology are described in general terms to protect the ownership
and the confidential information or trade secrets of ASC.

The software programs and the manuals of ASC are protected by copyright law. All rights on the
manuals are reserved including the rights of reproduction and multiplication of any kind, be it
photo mechanical, typographical or on digital data media. This also applies to translations.
Copying the manuals, completely or in parts, is only allowed with written authorization of ASC.

Representative, if not defined otherwise, is the technical status at the time of the delivery of the
software, the devices and the manuals of ASC. Technical changes without specified announce-
ments are reserved. Previous manuals lose their validity.

The general conditions of sales and delivery of ASC in their latest version apply.
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2 Introduction @sc

2 Introduction

The application REPORThneo is a central location for any type of reporting within the product
line neo. Different reports offer a diversified insight into the call landscape in your company. The
reports can be viewed in the application, printed as well as downloaded to be e-mailed to exter-
nal users in an attachment.

The reports provided in the system are either reports or dashboards:

* Reports display the selected data in tables and in graphic form in different levels of detail.
They are the foundation of a permanent and transparent reporting which serves as the
foundation for making well-informed operational and strategic decisions.

» A dashboard widget displays the current evolution of a performance indicator in graphical
form (e. g. bar charts or pie charts). Users can compile their customized dashboards includ-
ing the performance indicators relevant for them from different dashboard widgets which
grants them an overview of the status of decisive success factors or prioritized objective
targets.
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3 Licenses @sc

3 Licenses

No additional licenses are required for using the application REPORTneo.
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4 Start application

During the installation, a shortcut for the neo programs is created on the computer desktop.

1. To start the application directly on the server, double-click on the shortcut REPORTneo.
To access the application from a computer via the web, start the browser and enter the fol-
lowing URL in the address bar:
http://<System-IP>/REPORTneo

After you have entered the URL, the following login screen is displayed:

Login Combination Login

Login name*

Password*

Forgot password?

Fig. 1: Login screen

In general, there are the following login options:
+ Single login = normal user login, see chapter "Single login", p. 7

« Combination login, see chapter "Combination login”, p. 8

@ Your system administrator will tell you which login you have to use.
4.1 Single login
Login Combination Login
Login name*

Password*

Forgot password?

Fig. 2: Single login

1. Enter your user name and the password.
2. Click on the button -> Login.

= The welcome screen of the application appears.
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i} Start application &ASC

If you have forgotten your password and requested a new one upon your last login, the follow-
ing window appears:

Your password has expired.

Old password*
New password*

Confirm password*

Fig. 3: Your password has expired

3. Inthe entry field Old password, enter your new password you have received by e-mail.

4. In the entry field New password, enter your new, modified password.
5. Inthe entry field Confirm password, repeat your new, modified password.
6. Click on the button OK.
= The welcome screen of the application appears.
4.2 Combination login

For safety reasons, it may be sensible to assign a combination user to a user. That way it can
be ensured for instance that a supervisor only accesses recorded conversations when a mem-
ber of the work council is present.

If a combination user has been defined, the actual user is only allowed to log in when the com-
bination user has logged in, too. If entering the login data of a combination user is required, pro-
ceed as follows:

1. In the login window, click on the button Combination Login.

Login Combination Login

Login name*

Password*

Forgot password?

Fig. 4: Login

2. The window Combination Login appears.

- neo 6.x Rev. 2 8/25



i} Start application @sc
Login Combination Login
Login name*

Password*
Combination user*

Combination password*

Forgot password?

Fig. 5: Combination login

3. Enter your user name and your password as well as the user name and password of your
combination user.

4. Click on the button -> Login.
= The welcome screen of the application appears.
To change to the normal login, if required, click on the button Login.

If you have forgotten your password and requested a new one upon your last login, the follow-
ing window appears:

Your password has expired.

Old password*
New password*

Confirm password*

Fig. 6: Your password has expired

5. Inthe entry field Old password, enter your new password you have received by e-mail.

6. Inthe entry field New password, enter your new, modified password.
7. Inthe entry field Confirm password, repeat your new, modified password.
8. Click on the button OK.
= The welcome screen of the application appears.
4.3 Request new password

If you have forgotten your password, you can request a new one via the function Forgot pass-
word? in the different login windows.

1. Click on the text Forgot password?

- neo 6.x Rev. 2 9/25
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Login Combination Login
Login name*

Password*

Forgot password?

Fig. 7: Login window

2. The window Forgot password? appears.

Forgot password?

Login name*

Back

Fig. 8: Request password

3. Enter your user name.
4. Click on the button -> Reset Password.
= You will receive an e-mail containing your new password.

® For this function, your administrator has to have configured a corresponding e-mail server.
Contact your system administrator if you do not receive an e-mail after this step.

5. To return to the login, click on the text Back.
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5 User interface REPORTneo ‘\Asc

5 User interface REPORTnheo
The user interface of REPORTneo is divided into a dashboard with an overview of all widgets
and the corresponding widget settings in a detail view as well as into a main view of the se-
lected report and the corresponding detail report settings in a detail view.

5.1 Dashboard

This overview dashboard serves as entry platform of REPORTneo and displays all created re-
ports in widgets.

(asc 1 ce

Agent Recanding Dutbound Cals Agent Recording Tetal Cals Agent Recording Unknown Calis
Agent iccending Intemal Calls Agent ieconding mbound Calls

® @

Fig. 9: Main view widgets (example)

Here, you can create new report widgets, view the filter settings within an existing widget as well
as edit its settings.

1 Toolbar Contains functionalities for the elements in the main
view, see chapter "Toolbar dashboard", p. 12.

2 Widget To change the layout of the widgets on the dashboard,
hover the mouse cursor over the widget, click on the
icon +, and move the widget to the required position.

To change the size of the widget, hove the mouse cursor
over the widget, click on the small gray triangle in the
bottom right corner and drag the widget to the required
size.

— When hovering the mouse cursor over this icon, the cur-
rent filter and aggregation settings of the report are dis-

(Filter settings) played.
e Opens the detailed view of the widget settings for indi-
vidual configuration purposes, see chapter "Widget set-
(Settings) tings", p. 12.
3 ° Adds a new report widget, see chapter "Create report
widget", p. 19.
(Add new widget)

- neo 6.x Rev. 2
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5 User interface REPORTneo ‘\Asc
511 Toolbar dashboard

5.2

5.21

The toolbar of the dashboard offers the following functionalities:

C @ f1stTenant Admin

Fig. 10: Toolbar dashboard
C Refresh Refreshes the widgets displayed in the overview.

e Logged in as Opens a drop-down menu with different general functionalities,
see chapter "General functionalities”, p. 18.

Version info Menu item which allows calling up information about the version of
the software, see chapter "Call up info", p. 18.

Logoff Menu item which allows logging off from the application.

To close the application, always use the logoff function.
@ (Logged in as) > Logoff.

Widget settings
Click on the icon = (Settings) in the dashboard to open the detail view of the widget settings.

The detail view contains additional information about and functions of the selected widget.

Settings []
4 General Additional Settings = »
Type *

Stacked bar v
Cha_n;in; the type may result in resetting your current

FaliRos.

Agent Recording Report (agent based)

Refresh interval * -

Save Cancel

Fig. 11: Detail view widgets (example)

The detail view consists of the following tabs:

» General
Here, the general settings of the selected report widget are displayed, see chapter "Tab
General", p. 12.

» Additional Settings
Here, you can select additional indicators (KPI) which are supposed to appear in the wid-
get, see chapter "Tab Additional Settings", p. 13.

Tab General
Here, the settings of the selected report widget are displayed and can be edited.

- neo 6.x Rev. 2
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5 User interface REPORTneo ‘\Asc
General Additional Settings = »
Type *
Stacked bar v
Changing the type may resultin resetting your current settings.

Title ™

Agent Recording Report (agent based)

Refresh interval * -

Fig. 12: Tab General (example)

Type Select the representation type of the report widget from the drop-down list.

Depending on the selected report, different representation types are avail-
able, e. g.:

» Stacked bar
» Doughnut
* Funnel

* Number

» Spline

Name Enter a descriptive title for the report widget. If you do not enter a title, the
default name will be used.

Refresh interval ~ Select the interval in which the report widget is supposed to refresh.

To save the settings, click on the button Save.
To discard the settings and return to the main view of the report, click on the button Cancel.

5.2.2 Tab Additional Settings
Here, you can select additional indicators (KPI) which are supposed to appear in the widget.

General Additional Settings
KPI selection -
Save Cancel

Fig. 13: Tab Additional Settings (example)

KPI selection Select the required indicators from the drop-down list.
Depending on the widget type, one or several KPIs can be selected.
O = No KPI has been activated.
= KPI has been activated.

To save the KPlIs selected in the drop-down list, click in the detail view.
To discard the selected KPIs, click on the checked check box once again. To discard all se-
lected KPIs at the same time and cancel the selection process, click on the button Clear.

To eventually save the settings, click on the button Save.
To discard the settings and return to the main view of the report, click on the button Cancel.
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5 User interface REPORTneo ‘\Asc
5.3 Main view report
The main view of the report displays detailed information about the report of the widget selected
in the main view.
< &LASC - ] e 1sl-Tenaal Admin
Agent Recording Total Calls
Cats Recording Reowil based en Agenls
Fig. 14: Main view of a separate report (example)
By means of the blue bar below the displayed report, the columns can be move to different loca-
tions by drag and drop. Clicking on a column sorts the content.
By clicking on the icon a (Export), you can export the report as an .xcl file. Check the check
box in the first column of the blue bar to export all columns or select the required columns man-
ually.
By means of the search field, you can search for certain terms in the table. If a search has been
successful, only those lines are displayed which contain the search term which is highlighted.
The column overview of the table remains.
5.31 Toolbar report

The toolbar in the main view of the report offers the following functionalities:

& & @ istTenantAdmin

Fig. 15: Toolbar report

O Settings Allows creating new reports as well as configuring the settings of a
report selected in the overview, see chapter "Create report wid-
get", p. 19.

= Print Allows printing the report, see chapter "Print", p. 18.

Logged in as Opens a drop-down menu with different general functionalities,
see chapter "General functionalities", p. 18.

@

Info Menu item which allows calling up information about the version of
the software, see chapter "Call up info", p. 18.

Logoff Menu item which allows logging off from the application.

- neo 6.x Rev. 2
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5.4

5.4.1

To close the application, always use the logoff function.
@ (Logged in as) > Logoff.

Detail report settings

Click on the icon & (Settings) in the toolbar of the main view of the report to open the detail
view of the report.

The detail view contains additional information about and functions of the selected report.

Settings [ ]
Report settings Filters Agaregation
Type *
Changing the type may resultin resetting your current settings.

Title ™
Agent Recording Report (agent-based)

Description
Call recording report based on agents|

Cancel

Fig. 16: Detail view report (example)

The detail view consists of the following tabs:

* Report settings
Here, the settings of the selected report are displayed, see chapter "Tab Report settings",

p. 15.

* Filters
Here, possible filter criteria are displayed which can be applied to the data displayed in the

report, see chapter "Tab Filters", p. 16.

* Aggregation
Here, the aggregation settings are displayed, see chapter "Tab Aggregation”, p. 17.

Tab Report settings
Here, the settings of the selected report are displayed and can be edited.

151725
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5 User interface REPORTneo \Asc
N\
Report settings Filters >
TS}::cxked bar -

Changing the type may resultin resetting your current settings.
Title *

Agent Recording Total Calls

Description

Calls Recording Report based on Agents

Cancel

Fig. 17: Tab Report Settings (example)

Type Select the representation type of the report from the drop-down list.

Depending on the selected report, different representation types are avail-
able, e. g.:

» Stacked bar
* Doughnut
* Funnel

* Number

» Spline

Title Enter a descriptive title for the report. If you do not enter a title, the default
name will be used.

Description Enter a description of the report.

5.4.2 Tab Filters

Depending on the selected report, different filter criteria can be selected which are supposed to
be applied to the data displayed in the report.

4 Report settings Filters

8/18/2020 B ©  9/18/2020 B

Cancel

Fig. 18: Tab Filters (example)

@) In the calendar, select the beginning and the end of the period of time that
the report is supposed to cover or enter the date manually.

c | : Click on the icon @ to enter a specific period of the time.

Click on the icon @ to select a predefined period of time from the drop-down
list below, e. g. Today, Last week, etc.

- neo 6.x Rev. 2 16 /25
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£

To save the settings, click on the button Save.
To discard the settings, click on the button Cancel.

543 Tab Aggregation
Here, you can select the aggregation settings of the report widget.

¢ | Report settings Filters Aggregation

Duration Format

Seconds -
Time slices
Year -

Fig. 19: Tab Aggregation (example)

Duration format ~ Select the duration format from the drop-down list.
The following options are available:
» Seconds
* Minutes
* Hours
Time slices Select the time slice from the drop-down list.
The following options are available:
* Year
* Quarter
* Month
* Week
« Day

To save the settings, click on the button Save.
To discard the settings and return to the main view of the report, click on the button Cancel.

- neo 6.x Rev. 2 17125
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6 General functionalities

6.1 Call up info
1. Click on the menu item @ Logged in as > Info in the top right corner of the user interface.
= The following window appears:

Version Info

Current Version: 6.5.0-1.0

Close

Fig. 20: Call up info (example)

2. To close the window, click on the button Close.

6.2 Print
This function allows printing the report.

v' Print default in the browser under File > Page Setup: Page orientation has been set to land-
scape

v/ Additionally when using the browser Mozilla Firefox:
Print default in the browser under File > Page Setup: Scaling has been set to 110 %.

1. Click on the icon & in the toolbar of the report.
= The print preview appears.

2. To cancel the printing process, click on the button Cancel.
To continue the printing process, click on the button Print.

= The window Print appears.

Drucken *
Drucker
Mame: ‘WASC-IT3 asc.de'\R&D Kopierer Ricoh  ~ | | Eigenschaften...
Status: Bereit
Typ: RICOH MP C2504 PCL &

Standort: 1.0G/Flur (Raum 102)
Kommentar: Kopierer/Drucker A3 + Duplex 5/W-+color & [ Ausgabe in Datei

Druckbereich Exemplare
@ Ales Anzahl Exemplare: |1 o
() Set 21 bis: |1
stenven * _’ﬂ _’J _’ﬂ Sortieren
Markierung l; 2 3
Abbrechen

Fig. 21: Print (example)

3. Set the respective print options.

4. To start printing, click on the button OK.
To cancel the printing process, click on the button Cancel.

- neo 6.x Rev. 2 18/25



ASC

7 Create report widget \

£

7 Create report widget

1. Click on the icon @ at the bottom right of the dashboard.
= The following window appears:

Add Widget X

Q Recording| (%]

Analysis report

‘ Agen Report (agent based)
0 g Calls [JZeslfs[l3ls] Report based on Agents
i "':"3'==;-,/_-; 8] hep g

Cancel

Fig. 22: Add report widget
2. Select the report that is supposed to be displayed in the widget from the list.
By means of the search, you can search for certain reports.

3. Enter the name of the report in the search field. While entering the first letters, the names of
reports containing this combination of letters is auto-completed and displayed in a list.

4. To select the report and add the widget, click on the button Add.
To cancel the process, click on the button Cancel.

= Upon clicking on the button Add, the widget is displayed on the overview dashboard.

- neo 6.x Rev. 2 19/25
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8 Configure widget

\(asc

C & stTenant Agmin

Agent Azcording Cutsound Cais Agent Recording Total Cais Agent Rcording Unknown cals

0 2 0

Agent fecoring intemal Calls Agent ficeording mbound Calls

2 0

Fig. 23: Configure widget (example)

1.  On the dashboard in the widget, click on the icon % .

= The detail widget settings appear:

Settings []
4 General Additional Settings = »
Type *

Stacked bar v

Cha_nging the type may result in resetting your current
FaliRos.

Agent Recording Report (agent based)

Refresh interval * -

Save Cancel

Fig. 24: Detail view (example)

2. Adjust the required settings in the tabs of the widget settings, see chapter "Widget set-

tings", p. 12.

3. To save the changes, click on the button Save.
To discard the entries, click on the button Cancel.
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Configure report

1. Select a widget on the dashboard.
= The main view of the report appears:

< &LASC - ] e 1sl-Tenaal Admin

Agent Recording Total Calls

Cats Recording Reacil based on Agenls

Irkcund Cals Catbound Cals frbemal Cale inimeen Cale Tetal Cake
Hecorded Lall:
-

Fig. 25: Configure report

2. Click on the icon # in the toolbar of the main view of the report.
= The detail report settings appear:

Settings []

Report settings Filters Aggregation

Type *

Changing the type may resultin resetting your current settings.
Title *

Agent Recording Report (agent-based)

Description
Call recording report based on agents|

Cancel

Fig. 26: Detail view (example)
3. Adjust the required settings in the tabs of the detail view, see chapter "Detail report set-
tings", p. 15.

4. To save the changes, click on the button Save.
To discard the changes, click on the button Cancel.

- neo 6.x Rev. 2
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10 Delete widget

1. To delete a widget, click either on the icon # within a widget on the dashboard or on the
widget itself.

= The detail report settings appear:

Settings []

Report settings Filters Aggregation

Type *

Changing the type may resultin resetting your current settings.
Title *

Agent Recording Report (agent-based)

Description
Call recording report based on agents|

Cancel
Fig. 27: Detail report settings (example)

2. Click on the icon @ in the header of the detail report settings.
3. Toreally delete the widget, confirm the security prompt.
= The widget is deleted.
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Glossary

KPI
Key performance indicator

URL
Uniform resource locator. Identifies and locates a resource (e. g. a website) about the used
access method (e. g. the used network protocol as HTTP or FTP) and the location of the re-
source in the computer network. (Source: Wikipedia 20th November 2013)

Widget
Component of a graphical dialog system. Consists of a visible window and an invisible object
which saves the configuration of the component. Is used for the interaction with the user and
the automatically updatable display of information.
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